j LibreOffice

The Document Foundation

Handleiding voor beginners

Hoofdstuk 7
Kennismaken met Draw

Vectortekeningen in LibreOffice

Documentatie voor LibreOffice is beschikbaar op

y N D - A h www.nl.libreoffice.org/ondersteuning/documentatie/
= 0 ‘- U [ 0 rS en www.odfauthors.org/libreoffice/nederlands


https://nl.libreoffice.org/ondersteuning/documentatie/

Kennismaken met Draw



Auteursrechten

Dit document is onder auteursrecht © 2010 — 2016 van de bijdragers die onderstaand zijn
genoemd. U mag het verspreiden en/of aanpassen met inachtneming van de condities van GNU
General Public License (http://www.gnu.org/licenses/gpl.html), versie 3 of hoger of de Creative
Commons Attribution License (http://creativecommons.org/licenses/by/4.0), versie 4 of hoger.

Alle handelsmerken in deze gids zijn eigendom van de rechtmatige eigenaars.

Auteur(s)

Peter Schoffie Jean Hollis Weber Hazel Russman
Ron Faile Jr.

Reacties

Opmerkingen en suggesties kunnen aan de oorspronkelijke auteurs van de Engelstalige
handleiding via de mailinglijst van het documentatieteam (documentation@global.libreoffice.org)
gezonden worden.

Opmerking: alles wat u naar de mailinglijst stuurt, inclusief uw e-mailadres en andere persoonlijke
informatie die in het bericht staat, wordt openbaar gearchiveerd en kan niet verwijderd worden.

Heeft u op- of aanmerkingen over de Nederlandstalige vertalingen dan kunt u terecht op de
mailinglijst: discuss@nl.libreoffice.org

Inschrijven kan via een mailtje aan discuss+subscribe @nl.libreoffice.org

Dankbetuigingen

Deze handleiding is gebaseerd op en bijgewerkt van eerdere versies van dit hoofdstuk. De
medewerkers hieraan zijn:

Agnes Belzunce Chris Bonde Daniel Carrera
Regina Henschel Michel Pinquier lain Roberts

Gary Schnabl Joe Sellman Jim Taylor

Alex Thurgood Jean Hollis Weber Linda Worthington
Michele Zarri

Vertalers

Kees Kriek

Publicatiedatum en softwareversie
Gepubliceerd 22 januari 2016. Gebaseerd op LibreOffice 5.0.
Vertaling maart 2016

Kennismaken met Draw

fii


mailto:discuss@nl.libreoffice.org

Opmerking voor gebruikers van een Mac

Sommige toetsaanslagen en menu-items zijn anders op een Mac dan die in Windows en Linux. De
tabel hieronder geeft enkele algemene vervangingen voor de instructies in dit hoofdstuk. Voor een
meer gedetailleerde lijst, bekijk de Help van deze toepassing.

Menuselectie Extra > LibreOffice > Voorkeuren Toegang tot instellingsopties

Opties

Klik met rechts Control+klik Contextmenu openen

Ctrl (Control) # (Command) Gebruikt met andere toetsen

F5 Shift+36 +F5 De Navigator openen

Fi1 3} +T Het venster Stijlen en opmaak openen
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Wat is Draw?

LibreOffice Draw is een tekenprogramma voor vectorafbeeldingen, hoewel het ook enkele
bewerkingen op rasterafbeeldingen (pixels) kan uitvoeren. Door Draw te gebruiken kunt u snel een
groot scala aan grafische afbeeldingen maken.

Vectorafbeeldingen slaan afbeeldingen op en geven deze weer, als samenstelling van eenvoudige
geometrische elementen zoals lijnen, cirkels en veelhoeken in plaats van een verzameling pixels
(punten op het scherm). Vectorafbeeldingen maken eenvoudige opslag en het op een andere
schaal weergeven mogelijk.

Draw is volledig in het kantoorpakket LibreOffice geintegreerd en dit vereenvoudigt het uitwisselen
van afbeeldingen tussen alle componenten van het pakket. Als u bijvoorbeeld een afbeelding
maakt in Draw, is het opnieuw gebruiken daarvan in een Writer-document net zo eenvoudig als het
kopiéren en plakken van die afbeelding. U kunt ook rechtstreeks met afbeeldingen werken in
Writer en Impress, waarbij u een deel van de functies en gereedschappen van Draw kunt
gebruiken.

De functionaliteit van Draw is uitgebreid; hoewel het niet werd ontworpen om te concurreren met
andere uitmuntende grafische toepassingen, bezit Draw toch meer functies dan de meeste
tekenprogramma'’s die in kantoorpakketten geintegreerd zijn.

Een aantal voorbeelden van tekenfuncties zijn: Lagenbeheer, Magnetisch systeem van
rasterpunten, Weergave van dimensies en maateenheden, Verbindingen voor het maken van
organogrammen, 3D-functies die het mogelijk maken kleine driedimensionale tekeningen te maken
(met textuur- en belichtingseffecten), Integratie van tekenobject- en paginaopmaakprofielen,
Bézier-bogen.

Dit hoofdstuk introduceert een aantal functies van Draw, maar niet alle functies worden besproken.
Bekijk de Handleiding voor Draw en de Help-functie voor meer informatie.

Het hoofdvenster van Draw

De belangrijkste componenten van de werkruimte van Draw worden getoond in Afbeelding 1:
* Menubalk
* Werkbalk Standaard
* Paginavenster
e  Werkruimte
e Statusbalk
* Werkbalk Tekening
* Zijbalk

Werkruimte

Het grote gebied in het midden van het venster (Werkruimte) is waar u uw tekeningen maakt en dit
tekengebied kan door werkbalken en informatiegebieden omringd worden. Het aantal en de positie
van de zichtbare werkbalken wisselt, afhankelijk van de te volbrengen taak en de
gebruikersvoorkeuren, daardoor kan uw weergave er anders uit zien dan in Afbeelding 1.

De maximale afmeting van een afbeelding in LibreOffice Draw is 300 cm bij 300 cm.

Het hoofdvenster van Draw 7



[} Geen titel 1 - LibreOffice Draw = O X
Bestand Bewerken Beeld Invoegen Opmaak Extra Wijzigen Venster Help
‘E-EB-HE BRES KB &g B - i g @ TE @ --2- & < 7%
& _Pagina's x || 331 112+31415]60 71819 101112113114 1§16'17 1819120121122 A Eigenschappen @ 0| =
& 1 & Teken =
& Alinea =] 2
4 - i . »
= Gebied =]
% o N enil
: Vullen: o
/ ‘ Ikteur | o — - ®)
= - L1 —~
® ) IIransparantle: -
n |Geen ~|10% =
- - o ! -
& J & Lijn =
"o T 7 Breedte: -
& - Kleur: {) I -
@- i Transparantie: 0% :
@ - ; Stij:
- = 7 o
.- 2 @ |7 Continu i
* - il
- ® [ geen- -]
@ i v | geen - =
< P . .
| » M | Lay-out | Besturingselementen | Maatlijnen Hoekstijl: Eindstiji: e
Vorm geselecteerd =550/ 1060 @ #1970 x4,50 3 Dia 1van 1 (Lay-out) Standaard #| -=0 +| 35%
1 Menubalk 4 Paginavenster 7 Werkbalk Tekening
2 Werkbalk Standaard 5 Werkruimte
3 Zijbalk 6 Statusbalk

Afbeelding 1: Werkruimte van Draw

Deelvenster pagina's

U kunt tekeningen in Draw over verschillende pagina's verdelen. Multipagina-tekeningen worden
meestal voor presentaties gebruikt. Het Deelvenster pagina geeft een overzicht van de pagina's
die u in uw tekening creéert. Als het Deelvenster pagina niet zichtbaar is, ga naar Beeld op de
Menubalk en selecteer Deelvenster pagina. Om de paginavolgorde te wijzigen, sleep één of
meerdere pagina's naar een ander positie.

Zijbalk

De Zijbalk heeft vier panelen. Om een paneel, dat u wilt gebruiken, naar voren te halen, klik op het
betreffende pictogram of klik op het kleine driehoekje boven de pictogrammen en kies het
gewenste paneel uit de keuzelijst. Er kan slechts één paneel tegelijk geopend worden. Als de
Zijbalk niet zichtbaar is, ga naar Beeld op de Menubalk en selecteer Zijbalk in de lijst.

Eigenschappen 5‘.‘

Opent gedeeltes voor objecteigenschappen, die u naar uw wensen kunt aanpassen. De
gedeeltes zijn: Voeg een vorm in, Teken, Alinea, Afbeelding, Lijn en Positie en Grootte.

Stijlen en opmaak y o3

Hier kunt u afbeeldings-opmaakprofielen aanpassen en toepassen op objecten in uw tekening.
Als u een opmaakprofiel aanpast, worden de wijzigingen automatisch toegepast op alle
elementen in uw tekening, die met dat profiel zijn opgemaakt.

8 Kennismaken met Draw



Galerij "%*

Opent de Galerij met tekeningen, waar u een object in uw tekening kunt invoegen, zowel een
kopie als een koppeling. Een kopie van een object is onafhankelijk van het oorspronkelijke
object. Wijzigingen aan het oorspronkelijke object hebben geen invioed op de kopie. Een
koppeling blijfit afhankelijk van het oorspronkelijke object. Wijzigingen aan het oorspronkelijke
object beinvioeden ook het gekoppelde object.

Navigator o

Opent de Navigator in Draw, waar u snel tussen de pagina's van uw tekening kunt wisselen of
een object van een tekening kunt selecteren. Het is aan te bevelen om pagina's en objecten in
uw tekening betekenisvolle namen te geven, zodat u ze in de Navigator gemakkelijk kunt
vinden.

Linialen

U zou linialen (balken met nummers) aan de boven- en linkerkant van de werkruimte moeten zien.
Als ze niet zichtbaar zijn, kunt u ze aanzetten door Beeld > Linialen op de Menubalk aan te
vinken. De linialen geven de grootte van een, op de pagina geselecteerd, object met grijze dubbele
lijntjes weer (zoals in gemarkeerd). Wanneer er geen object geselecteerd is, tonen ze
de locatie van de muisaanwijzer; dit helpt bij het meer nauwkeurig plaatsen van de tekenobjecten.

U kunt de linialen ook gebruiken om object-handvatten en hulplijnen te beheren, waardoor het
gemakkelijker wordt om objecten te plaatsen.

De pagina-marges in het tekengebied worden ook op de linialen weergegeven. U kunt de marges
rechtstreeks op de linialen wijzigen door deze te verslepen met de muis. De marges worden

aangegeven door grijze gebieden op de linialen, zoals in is te zien.
+71 O@
) o
= o

Afbeelding 2: Linialen die de afmetingen
van een geselecteerd object weergeven

Klik met rechts op één van de linialen en selecteer één van de maateenheden uit de keuzelijst (zie
) om de maateenheid van de linialen te wijzigen. De twee linialen kunnen
verschillende eenheden hebben.

Het hoofdvenster van Draw 9
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Afbeelding 3: Maateenheden liniaal

Statusbalk

De Statusbalk bevindt zich aan de onderzijde van de werkruimte (zoals in alle componenten van
LibreOffice); het bevat verscheidene velden die specifiek voor Draw zijn.

| Vorm geselecteerd =070/080 £ 9,70 x 4,550 E} Dia 1van 1 (Lay-out) | Standaard | | - = +| 75% |
1 Informatiegebied 4 Niet opgeslagen wijzigingen 7 Zoomschuifbalk
2 Positie 5 Digitale handtekening 8 Zoompercentage
3 Afmetingen object 6 Dianummer

Afbeelding 4: Statusbalk in Draw

@ opmerking

De groottes worden in de huidige maateenheid gegeven (niet te verwarren met de
eenheden op de linialen). De maateenheid van de Statusbalk wordt gedefinieerd in
Extra > Opties > LibreOffice Draw > Algemeen, waar u ook de schaling van de
pagina kunt wijzigen.

Werkbalken

Om de verschillende werkbalken van Draw weer te geven of te verbergen, ga naar Beeld >
Werkbalken. U kunt, uit het menu dat verschijnt, kiezen welke werkbalken u wilt tonen. Voor meer
over het werken met werkbalken, zie hoofdstuk 1 Kennismaken met LibreOffice in dit boek.

De gereedschappen die beschikbaar zijn op de werkbalken van Draw worden in de volgende
gedeelten nader uitgelegd. Het uiterlijk van de pictogrammen op de werkbalken kan variéren,
afhankelijk van uw besturingssysteem en de keuze van de grootte en stijl van de pictogrammen in
Extra > Opties > LibreOffice > Weergave.

10 Kennismaken met Draw



Werkbalk Standaard

De werkbalk Standaard is voor alle componenten van LibreOffice dezelfde en wordt in dit
hoofdstuk niet beschreven. Standaard is deze direct onder de Menubalk geplaatst.

Standaard v X
€H-ZB-BE &8 & B¢ i H B THE @ --0- 8 "

Afbeelding 5: Werkbalk Standaard

Werkbalk Tekening

De werkbalk Tekening is de belangrijkste werkbalk in Draw. Hij bevat alle nodige functies voor het
tekenen van verschillende geometrische en vrije hand-vormen en ook om ze op de pagina te
schikken. Standaard is deze verticaal vastgezet aan de linker zijde van het venster van Draw.

Tekening ¥ X
h& A8/ EH® 2" € L ¢-@-® - -P-&-3-

Afbeelding 6: Werkbalk Tekening

Werkbalk Lijn en opvulstijl

Met de werkbalk Lijn en opvulstijl kunt u de belangrijkste eigenschappen van een tekenobject
wijzigen. De pictogrammen en submenu's variéren afhankelijk van het type object, dat
geselecteerd is. Bijvoorbeeld, om de opmaak van een lijn te veranderen, klik op het pictogram van
de pijlstijl en kies de gewenste stijl.

De functies op deze werkbalk zijn ook beschikbaar op het paneel Eigenschappen van de Zijbalk,
als een tekenobject geselecteerd is. Standaard wordt de werkbalk Lijn en opvulstijl niet
weergegeven, maar kan zichtbaar worden gemaakt via het menu Beeld > Werkbalken.

Lijn en opwvulstijl v X
ff S |—————~ | L -000cm> A Kleur v | - = & - Be e - T -

Afbeelding 7: Werkbalk Lijn en opvulstijl

Werkbalk Tekstopmaak

Als het geselecteerde object tekst bevat, geeft de Zijbalk relevante informatie weer in het paneel
Eigenschappen. Standaard wordt werkbalk Tekstopmaak niet weergegeven, maar kan zichtbaar
worden gemaakt via het menu Beeld > Werkbalken. Als u zowel de werkbalk Lijn en opvulstijl als
de werkbalk Tekstopmaak aangezet heeft, schakelt Draw tussen de twee werkbalken, afhankelijk
van het geselecteerde object.

Tekstopmaak v X
Liberation Sans v |18 |~ |I€ & v € O M A-%& - EA @

(]
[
1]
[}
I
4

Afbeelding 8: Werkbalk Tekstopmaak
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Werkbalk Opties

Met de werkbalk Opties kunt u verschillende vormen van hulp bij het tekenen in- of uitschakelen.
Standaard wordt de werkbalk Opties niet weergegeven, maar kan zichtbaar worden gemaakt via
het menu Beeld > Werkbalken.

Opties v X

Afbeelding 9: Werkbalk Opties

Kleuren kiezen en definiéren

Gebruik Beeld > Werkbalken > Kleurenbalk om het huidige kleurenpalet (Afbeelding 10) weer te
geven. Standaard wordt de Kleurenbalk onder de werkruimte weergegeven. U kunt deze
verbergen of weergeven door op de knop Verbergen/Weergeven te klikken. Hier kunt u snel de
kleur kiezen voor objecten in uw tekening (lijnen, gebieden en 3D effecten). Het eerste vakje
correspondeert met Geen (geen kleur).

b b | Lay-out [ Besturingselementen | Maatlijnen

= ™29 28] 27
<

Fs

Afbeelding 10: Dialoogvenster Kleuren

U hebt toegang tot verschillende gespecialiseerde kleurenpaletten in Draw en ook de mogelijkheid
om individuele kleuren naar eigen smaak te definiéren. Dit kan door Opmaak > Vlak op de

Menubalk te kiezen of het pictogram Vlak a op de Zijjbalk te klikken en dan het tabblad Kleuren
te kiezen (Afbeelding 11).
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Afbeelding 11: Dialoogvenster Gebied, tabblad Kleuren

Klik op de knop Lijst met kleuren laden om een ander palet te laden. In het dialoogvenster
voor bestandsselectie wordt u gevraagd om te kiezen uit één van de standaard paletten van
LibreOffice (bestanden met de extensie *.soc). Bijvoorbeeld, web.soc is een kleurenpalet dat
speciaal is aangepast voor het maken van tekeningen in webpagina's. De kleuren worden correct
weergegeven op werkstations met schermen van ten minste 256 kleuren.

In het keuzevak voor de kleuren kunt u elke kleur afzonderlijk wijzigen door de numerieke waarden
aan te passen in de velden aan de rechterkant van het kleurenpalet. U kunt de kleurenschema's
bekend als CMYK (cyaan, magenta, geel, zwart) en RGB (rood, groen, blauw) gebruiken.

Klik op de knop Kies om het dialoogvenster Kies een kleur te openen, waar u de individuele
kleuren kunt instellen. Zie 'Kleuropties' in hoofdstuk 2 LibreOffice instellen van dit boek.

Voor een meer gedetailleerde beschrijving van kleurenpaletten en hun opties, zie hoofdstuk 10,
Gevorderde Tekentechnieken, in de Handleiding voor Draw.

Basisvormen tekenen

Draw levert een grote hoeveelheid vormen, geplaatst op paletten, die toegankelijk zijn via de
werkbalk Tekening.

Basisvormen tekenen 13
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‘l & Vrije-handlijn #  Lijn
" & Boog & Vrije-handlijn
&| < Punten 4" Boog
@| # Plakpunten = Rechthoek
@| w* Naar boog @ Ellips
E & Naar veelhoek e e e
3 & Naar 3D o 2| Boog
#%| «b Naar 3D-rotatieobject %l Verbinding
| 4 Besturingselementen
o : B <& Basisvormen
Extrusie aan/uit
@ symboolvormen
Zichtbare knoppen > s Blokpijlen
Werkbalk aanpassen... @ Stroomdiagrammen
&3 Toelichtingen
#1 Sterren
Werkbalkpositie vergrendelen & 3D-objecten
Werkbalk sluiten {%. Punten
. —4 Plakpunten
= Naar boog
- i Naar veelhoek
= & Naar 3D
@ «b Naar 3D-rotatieobject
< 28 Besturingselementen
Lay-out Besturing . .
& Extrusie aan/uit

Afbeelding 12: Beschikbare gereedschappen op de werkbalk Tekening

Deze alinea beschrijft slechts een aantal van de basisvormen, inclusief tekstvormen, welke in Draw
als objecten worden behandeld. Zie de Handleiding voor Draw voor een complete beschrijving van
de beschikbare vormen.

Sommige pictogrammen van de werkbalk Tekening wijzigen, afhankelijk van welke vorm van de
beschikbare vormen geselecteerd is. Pictogrammen met gereedschapspaletten worden
aangegeven met een klein driehoekje, rechts van het pictogram.

@ opmerking

Wanneer u een basisvorm tekent of er één selecteert om te bewerken, zal het veld Info
aan de linkerzijde van de Statusbalk wijzigen om de uitgevoerde actie te reflecteren:
Maken lijn, Tekstframe xxyy geselecteerd enzovoort.

Een rechte lijn tekenen

Klik op het pictogram Lijn /s op de werkbalk Tekening en plaats de muisaanwijzer daar waar u
wilt dat de lijn begint. Sleep de muisaanwijzer met de linkermuisknop ingedrukt. Laat de muisknop
los op het punt waar u wilt dat de lijn moet eindigen. Een handvat voor selectie verschijnt aan elk
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uiteinde van de lijn, wat aangeeft dat dit het huidige geselecteerde object is. Het handvat voor
selectie aan het beginpunt van de lijn is iets groter dan het andere handvat voor selectie.

Houd de Ctrl-toets ingedrukt terwijl u een lijn tekent, om het einde van de lijn aan het
dichtstbijzijnde rasterpunt te laten vangen.

@ opmerking

Dit is het standaardgedrag van de Ctrl-toets. Als de optie Vangen aan raster in het
menu Beeld > Raster echter geselecteerd is, zal de Ctrl-toets de activiteit Vangen
aan raster uitschakelen.

Houd de Shift-toets ingedrukt terwijl u de lijn tekent om de hoek van de lijn tot een veelvoud van
45 graden (0, 45, 90, 135 enzovoort) te begrenzen.

@ opmerking

Dit is het standaardgedrag van de Shift-toets. Als echter de optie Tijdens aanmaken of
verplaatsen van objecten in het gedeelte Vangpositie bij Extra > Opties > LibreOffce
Draw > Raster geselecteerd is, zal de actie van de Shift-toets het tegenovergestelde
zijn. Lijnen zullen automatisch met een veelvoud van hoeken van 45 graden worden
getekend, tenzij de Shift-toets wordt ingedrukt.

Beginpunt

Afbeelding 13: Een rechte
liin tekenen

Houd de Alt-toets ingedrukt tijdens het tekenen van de lijn om de lijn symmetrisch in beide
richtingen vanaf het beginpunt uit te breiden. Hierdoor kunt u lijnen tekenen door vanuit het midden
van de lijn te beginnen.

Als een lijn getekend is, gebruikt het de standaard attributen. Om deze attributen te wijzigen
selecteert u de lijn door er op te klikken, klik dan met rechts en kies Lijn in het contextmenu of ga
naar Opmaak > Lijn op de Menubalk om het dialoogvenster Lijn te openen (Afbeelding 14). U

[]
kunt ook op het pictogram Eigenschappen “ op de Zijbalk klikken om het gedeelte Lijjn te
openen. Lijnstijl, lijndikte en lijnkleur kunnen ook op de werkbalk Lijn en opvulstijl worden
gewijzigd.
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Lijn X
Liin Schaduw Lijnstijlen Pijlstijlen
Lijneigenschappen Pijlstijlen
Stijl: Startstijl: Einde stijl:
|— geen - V| ‘— geen - "
Kleur: Breedte Breedte
|- Zwart > | 020 cm ¢ 0,20 cm %
Breedte: Gecentreerd Gecentreerd
0,00 cm |3 O Synchroniseer uiteinden
Transparantie: Hoek- en kapstijlen
0% S Hoekstijl: Afkapstijl:
Afgerond |~ | ‘Plat v |

Help

NN

Annuleren

Herstellen

Afbeelding 14: Dialoogvenster Lijn

Een pijl tekenen

Pijlen worden getekend zoals lijnen. Draw classificeert pijlen als een subgroep van lijnen: Lijnen
met pijlpunten. Ze worden in het veld Informatie op de statusbalk als lijnen weergegeven. Klik op
het pictogram Lijn met pijluiteinde =% op de werkbalk Tekening of het gedeelte Voeg een vorm
in op de Zijbalk om een pijl te tekenen. De pijlpunt wordt aan het uiteinde van de pijl getekend als u
de muisknop los laat.

Lijnuiteinden kiezen

Verschillende soorten lijnuiteinden (pijlen, cirkels, vierkanten en andere) zijn beschikbaar in Draw.
Klik op het kleine zwarte driehoekje naast het pictogram Lijnen en pijlen =% op de werkbalk
Tekening of op het gedeelte Voeg een vorm in van het paneel Eigenschappen van de Zijbalk om
een palet te openen dat gereedschappen bevat om lijnen en pijlen te tekenen. U kunt ook naar
Beeld > Werkbalken > Pijlen gaan om de werkbalk Pjjlen als zwevende werkbalk te openen
(Afbeelding 15). Het pictogram van het meest gebruikte gereedschap zal op de werkbalk Tekening
worden getoond, om het makkelijk te maken dezelfde vorm opnieuw te gebruiken.

Na het tekenen van de lijn kunt u de pijlstijl aanpassen, door op het pictogram Pijlpunten = op
de werkbalk Lijn en opvulstijl te klikken en de start- en eindopties van de pijl te kiezen.
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Pijlen v X

I R R Rl

@@“@@.‘..

1 Lijn 5 Lijn (45°) 8 Lijn met vierkant/pijl
2 Lijn begint met pijl 6 Lijn eindigt met pijl 9 Maatlijn
3 Lijn met pijl/cirkel 7 Lijn met cirkel/pijl 10 Lijn met 2 pijlen

4 Lijn met pijl/vierkant

Afbeelding 15: Werkbalk Pijlen met beschikbare vormen

Een rechthoek of vierkant tekenen

Rechthoeken tekenen gaat op dezelfde wijze als het tekenen van een rechte lijn. Klik op het

pictogram Rechthoek = op de werkbalk Tekening of het gedeelte Voeg een vorm in, op het
paneel Eigenschappen van de Zijbalk. Als u de rechthoek met de muisaanwijzer tekent, bepaalt de
cursor de diagonaal tegenover liggende hoek (dit is afhankelijk van de manier waarop u een
rechthoek tekent).

Vierkanten zijn rechthoeken met gelijke zijden. Houd de Shift-toets ingedrukt om een vierkant te
tekenen.

6 Opmerking

Als de optie Tijdens aanmaken of verplaatsen van objecten in het gedeelte Vangpositie
bij Extra > Opties > LibreOffice Draw > Raster is geselecteerd, is de actie van de
Shift-toets omgekeerd. Als het gereedschap Rechthoek is geselecteerd, wordt een
vierkant getekend. Om een rechthoek te tekenen moet de Shift-toets tijdens het
tekenen ingedrukt worden. Deze omgekeerde werking van de Shift-toets werkt
hetzelfde bij het tekenen van ellipsen en cirkels.

Houd de Alt-toets ingedrukt om een rechthoek of een vierkant vanuit zijn middelpunt te tekenen.
De rechthoek of het vierkant gebruikt het startpunt (waar u als eerste met de muis klikte) als
middelpunt.

Een cirkel of een ellips tekenen

Gebruik het pictogram Ellips ““ op de werkbalk Tekening of het gedeelte Voeg een vorm in, in
het paneel Eigenschappen van de Zijbalk om een ellips of een cirkel te tekenen. Een cirkel is een
ellips waarvan de twee assen dezelfde lengte hebben. Om een cirkel te tekenen, klik op het
pictogram Ellips en houd de Shift-toets ingedrukt terwijl u de cirkel tekent.

Houd de Alt-toets ingedrukt om een ellips of een cirkel vanuit zijn middelpunt te tekenen. De ellips
of de cirkel gebruikt het startpunt (waar u als eerste met de muis klikte) als middelpunt.
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@ opmerking

Als u eerst de Ctrl-toets indrukt en ingedrukt houdt en dan pas op de pictogrammen
voor Lijn, Rechthoek, Ellips of Tekst klikt, wordt automatisch een object met een
standaard afmeting in het werkgebied getekend; de afmeting, vorm en kleur zijn
allemaal standaardwaarden. Deze attributen kunnen, indien nodig, later gewijzigd
worden. Bekijk de Handleiding voor Draw voor meer informatie.

Bogen of veelhoeken tekenen

Klik op het pictogram Boog A4 op de werkbalk Tekening of het gedeelte Voeg een vorm in, in het
paneel Eigenschappen van de Zijbalk om een boog of een veelhoek te tekenen. Klik op het kleine
driehoekje naast het pictogram om een vormenpallet met beschikbare bogen en veelhoeken te
openen (Afbeelding 17). Het gereedschap van de meest recentelijk gebruikte vorm wordt op de
werkbalk Tekening getoond om het gemakkelijk opnieuw te kunnen gebruiken.

Als u de muiscursor boven één van de pictogrammen beweegt, verschijnt een Helptip met de
beschrijving van de functie.

Bogen ¥ X
AP ol > S LW AN ™

60000000,

1 Vrije-handlijn 4 Veelhoek (45°) 7 Veelhoek, gevuld
2 Boog 5 Vrije-handlijn, gevuld 8 Veelhoek (45°), gevuld
3 Veelhoek 6 Boog, gevuld

Afbeelding 16: Werkbalk Bogen

@ opmerking

De muiscursor over dit pictogram bewegen geeft een Helptip voor Boog. Als u werkbalk
zwevend maakt, wordt de titel Bogen zichtbaar, zoals weergegeven in Afbeelding 16.
Het ingedrukt houden van de Shift-toets tijdens het tekenen van lijnen, nadat het
gereedschap van bogen of veelhoeken is ingedrukt, zorgt voor hoeken van 45 of 90
graden.

Bogen

Houd de muisknop ingedrukt om het beginpunt van uw boog te maken, trek dan, met ingedrukte
linker muisknop, een lijn vanuit het beginpunt. Laat de muisknop los en beweeg de cursor om een
kromming in de lijn te maken tot er een boog ontstaat. Klik om het eindpunt van de boog vast te
zetten en de lijn op de pagina vast te zetten. Om uw lijn te vervolgen verplaatst u de cursor om een
rechte lijn te tekenen. Bij elke muisklik zet u een hoekpunt neer en kunt u een volgende rechte lijn
tekenen vanaf dat hoekpunt. Dubbelklikken beéindigt het tekenen van de lijn.

Een gevulde boog verbindt automatisch het laatste punt met het eerste punt om de figuur te sluiten
en de figuur wordt met de huidige standaard vulkleur opgevuld. Een boog zonder vulling zal na het
tekenen niet gesloten worden.
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Veelhoeken

Teken de eerste lijn vanuit het beginpunt met de linker muisknop ingedrukt. Zodra u de muisknop
loslaat, wordt een eerste hoekpunt getekend. Verplaats de cursor om de tweede lijn te tekenen. Bij
elke muisklik stelt u een hoekpunt in en kunt u een nieuwe lijn tekenen. Een dubbelklik beéindigt
het tekenen.

Een gevulde veelhoek verbindt automatisch het laatste punt met het eerste punt om de figuur af te
sluiten en vult het met de huidige standaard opvulkleur. Een veelhoek zonder vulling zal niet
worden gesloten aan het einde van de tekening.

Veelhoek 45°

Net als bij gewone veelhoeken worden deze gevormd door lijnen, maar met hoeken van 45 of 90
graden ertussen.

Vrije-handlijn
Met dit gereedschap kunt u tekenen, net zoals met een potlood. Houd de linkermuisknop ingedrukt

en sleep de muis om de gewenste lijnvorm te tekenen. Het is niet nodig om het tekenen met een
dubbele klik te beéindigen. Gewoon de muisknop loslaten en het tekenen is voltooid.

Als u Vrije-handlijn, gevuld hebt geselecteerd, wordt het eindpunt automatisch met het beginpunt
verbonden en wordt het object gevuld met de toepasselijke kleur.

Tekst toevoegen

Om het gereedschap Tekst te activeren, klik op het pictogram I voor horizontale tekst of op het

pictogram Verticale tekst ™ voor verticale tekst. Als het pictogram Verticale tekst niet aanwezig
is, controleer dan of de optie Aziatisch bij Extra > Opties > Taalinstellingen >Talen geselecteerd
is. U kunt de werkbalk Tekstopmaak activeren (Beeld > Werkbalken) of het gedeelte Teken in het
paneel Eigenschappen van de Zijjbalk gebruiken om het lettertype, tekstgrootte en andere
teksteigenschappen selecteren, voordat u met typen begint.

Als het gereedschap tekst geactiveerd is, klik op de locatie waar u de tekst wilt plaatsen. Er
verschijnt een klein tekstframe, die alleen een cursor bevat. Dit frame kan net als elk ander object
verplaatst worden. Een tekstframe is ook dynamisch en groeit naarmate u meer tekst invoert.

Bekijk het informatieveld in de Statusbalk: het toont dat u tekst invoert en het geeft ook
gedetailleerde informatie over de huidige locatie van de cursor, met alinea-, rij- en kolomnummers

( )-

Tekst in een frame typen (Tekstvak)

| Lay-out | Besturingselementen | Maatlijnen |

TekstBewerken: Alinea 1, Rij 1, Kolom 28 2,10 / 23,40
Afbeelding 17: Tekstinformatie in de Statusbalk

U kunt een regeleinde invoegen met de toetscombimate Shift+Enter of een nieuwe alinea
beginnen met de Enter-toets. Bij het invoegen van regeleinden of nieuwe alinea's beéindigt u het
invoegen van tekst niet en wordt het tekstframe ook niet verlaten. Als u klaar bent met typen, klikt u
ergens buiten het tekstframe om het invoegen of bewerken van tekst te beé&indigen.
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Teksteigenschappen kunnen ook gedurende de invoer veranderd worden, waarbij elke wijziging
vanaf de cursorpositie effect heeft. Om de eigenschappen voor alle tekst in het tekstframe te
wijzigen, moet u alle tekst in het tekstframe markeren.

U kunt opmaakprofielen voor afbeeldingen maken, die u opnieuw kunt gebruiken voor andere
tekstframes. Selecteer Opmaak > Stijlen en opmaak of druk op F11 om het venster Stijlen en

opmaak te openen of klik op het pictogram Stijlen en opmaak 2 op de Zijbalk.
Afbeeldingsprofielen hebben effect op alle tekst binnen een tekstframe. Om alleen delen van de
tekst op te maken, gebruikt u directe opmaak op de werkbalk Tekstopmaak of in het gedeelte
Teken van het paneel Eigenschappen op de Zijbalk.

Tekstframes kunnen ook gevuld worden met kleuren, schaduwen en andere attributen, net als alle
andere Draw-objecten. U kunt het frame draaien en tekst schrijven onder elke hoek. Deze opties
worden beschikbaar door met rechts te klikken op het object.

Gebruik het gereedschap Toelichtingen (ook wel tekstballonnen of afbeeldingslabels genoemd),
geplaatst op de werkbalk Tekening, om toelichtingen te maken.

Als u dubbelklikt op een object, op F2 drukt of op het pictogram Tekst, op de werkbalk Tekening,
klikt, als een object is geselecteerd, wordt de tekst aan het grafische object toegevoegd. Deze
tekst wordt onderdeel van het grafische object.

Een grafisch object is niet dynamisch en gedraagt zich niet als een tekstframe. Om de tekst tussen
de kaders van het object te houden, moet u alinea's gebruiken, regeleinden of een kleiner
tekstformaat gebruiken, de objectgrootte aanpassen of een combinatie van alle vier.

Voor meer over tekst, zie hoofdstuk 2, Basisvormen tekenen en hoofdstuk 10, Geavanceerde
technieken voor Draw, in de Handleiding voor Draw.

Plakpunten en verbindingen

Plakpunten
Alle Draw-objecten hebben plakpunten, die normaal niet zichtbaar zijn. Plakpunten worden

zichtbaar als het pictogram Verbinding = ™ op de werkbalk Tekening of in het gedeelte Voeg een
vorm in in het paneel Eigenschappen van de Zijbalk, wordt geselecteerd. De meeste objecten
hebben vier plakpunten, zoals weergegeven in . U kunt meer plakpunten toevoegen
en plakpunten aanpassen, met behulp van de werkbalk Plakpunten ( ). Ga naar
Beeld > Werkbalken > Plakpunten om deze werkbalk te openen.

Plakpunten zijn niet hetzelfde als de selectie-handvatten van een object. De handvatten zijn voor
het verplaatsen of wijzigen van de grootte van een object. Plakpunten worden gebruikt om een
verbindingslijn aan een object vast te zetten of te plakken zodat, wanneer een object verplaatst
wordt, de connector met het object verbonden bilijft. Bekijk, voor een meer gedetailleerde
beschrijving van het gebruik van plakpunten, Hoofdstuk 3, Werken met objecten en objectpunten
en Hoofdstuk 8, Verbindingen, stroomdiagrammen en organisatieschema's van de Handleiding
voor Draw.

Afbeelding 18: Vier
plakpunten
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Plakpunten v X

& 1

B | v B Do by |5
® O ©OEE W
1 Plakpunt invoegen 5 Verdwijnen naar beneden 9 Plakpunt horizontaal rechts uitgelijnd

2 Verdwijnen naar links 6 Plakpuntpositie positief relatief 10 Plakpunt verticaal boven uitgelijnd

3 Verdwijnen naar boven 7 Plakpunt horizontaal links 11 Plakpunt verticaal gecentreerd
uitgelijnd

4 Verdwijnen naar rechts 8 Plakpunt horizontaal 12 Plakpunt verticaal beneden uitgelijnd
gecentreerd

Afbeelding 19: Werkbalk Plakpunten

Verbindingen

Verbindingen zijn lijnen en pijlen waarvan de uiteinden automatisch vangen aan plakpunten van
een object. Verbindingen zijn zeer bruikbaar voor het tekenen van organisatieschema'’s,
stroomdiagrammen en gedachtekaarten. Als objecten verplaatst of gerangschikt worden, blijven de
verbindingen automatisch met de plakpunten verbonden. Afbeelding 20 toont een voorbeeld van
twee objecten met een verbinding.

Draw biedt verscheidene verbindingen en verbindingsfuncties. Op de werkbalk Tekening of in het
gedeelte Voeg een vorm in in het paneel Eigenschappen van de Zijbalk, klikt u op het driehoekje
naast het pictogram Verbinding om de werkbalk Verbindingen te openen (Afbeelding 21). Bekijk,
voor een meer gedetailleerde beschrijving van het gebruik van verbindingen, Hoofdstuk 8,
Verbindingen, stroomdiagrammen en organisatieschema's van de Handleiding voor Draw.

&

Afbeelding 20: Een verbinding tussen twee objecten
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Verbindingen v X
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1  Verbinding 11 Directe verbinding met pijlen 21 Gebogen verbinding met
cirkels
2 Verbinding met pijlbegin 12 Directe verbinding met 22 Lijnverbinding
cirkelbegin
3 Verbinding met pijluiteinde 13 Directe verbinding met 23 Lijnverbinding met pijlbegin
cirkeluiteinde
Verbinding met pijlen 14 Directe verbinding met cirkels 24 Lijnverbinding met pijluiteinde
Verbinding met cirkelbegin 15 Gebogen verbinding 25 Lijnverbinding met pijlen
Verbinding met cirkeluiteinde 16 Gebogen verbinding met 26 Lijnverbinding met cirkelbegin
pijlbegin
7  Verbinding met cirkels 17 Gebogen verbinding met 27 Lijnverbinding met
pijluiteinde cirkeluiteinde
8 Directe verbinding 18 Gebogen verbinding met 28 Lijnverbinding met cirkels
pijlen
9 Directe verbinding met 19 Gebogen verbinding met
pijlbegin cirkelbegin
10 Directe verbinding met 20 Gebogen verbinding met
pijluiteinde cirkeluiteinde

Afbeelding 21: Werkbalk Verbindingen

Geometrische vormen tekenen

De pictogrammen voor het tekenen van geometrische vormen bevinden zich op de werkbalk
Tekening. De geometrische vormen vormen wordt in de volgende secties beschreven. Door op het
driehoekje rechts van een pictogram op de werkbalk Tekening te klikken opent een zwevende
werkbalk met geometrische vormen.

} Tip

Het gebruik van al deze gereedschappen voor geometrische vormen is vergelijkbaar
met die van het gereedschap Rechthoek. Voor meer informatie, zie 13 en Hoofdstuk 2,
Basisvormen tekenen, in de Handleiding voor Draw.

@ opmerking

De pictogrammen voor geometrische vormen op de werkbalk Tekening nemen de vorm
aan van het gereedschap die het laatst voor een object is gebruikt.

Basisvormen

Klik op het driehoekje rechts van het pictogram Basisvormen < ~ om de werkbalk Basisvormen
te openen. Deze werkbalk bevat ook een driehoek die gelijk is aan die op de werkbalk Tekening.
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Basisvormen v X
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Afbeelding 22: Werkbalk Basisvormen

Symboolvormen

Klik op het driehoekje rechts van het pictogram Symboolvormen < ~ om de werkbalk
Symboolvormen te openen.

Symboolvormen v X

@wxI)eFVB@OPULU (IO ) ES® @

Afbeelding 23: Werkbalk Symboolvormen

Blokpijlen
Klik op het driehoekje rechts van het pictogram Blokpijlen < - om de werkbalk Blokpijlen te
openen.

Blokpijlen ¥ X
E2 ¢ e £ BEPSPLTe PRI EBRBGAYS

Afbeelding 24: Werkbalk Blokpijlen

Stroomdiagrammen

Klik op het driehoekje rechts van het pictogram Stroomdiagrammen il - om de werkbalk
Stroomdiagram te openen. Het maken van stroomdiagrammen, organisatieschema's en
vergelijkbare planningsgereedschappen worden gedetailleerder beschreven in Hoofdstuk 8,
Verbindingen, stroomdiagrammen en organisatieschema's, van de Handleiding voor Draw.

Stroomdiagram v X

HeSIFIEHPFe=eavOaAAPXSLAVEPCQ@QSESD @

Afbeelding 25: Werkbalk Stroomdiagram

Toelichtingen

Klik op het driehoekje rechts van het pictogram Toelichtingen [E ~ om de werkbalk Toelichtingen
te openen.

Toelichtingen ¥ X
e .EE e

Afbeelding 26:
Werkbalk Toelichtingen
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Sterren en banners

Klik op het driehoekje rechts van het pictogram Sterren ¥4 T om de werkbalk Sterren en banners
te openen.

Sterren en banners v X

TR BEEREPHTEE O

Afbeelding 27: Werkbalk Sterren en
banners

@ opmerking

U kunt tekst aan alle geometrische vormen toevoegen. Voor meer informatie, zie
Hoofdstuk 2, Basisvormen tekenen en Hoofdstuk 10, Gevorderde Draw-technieken,
van de Handleiding voor Draw.

Objecten selecteren

Directe selectie

De eenvoudigste manier om een object te selecteren is door er op te klikken. Objecten die niet
gevuld zijn, kunnen geselecteerd worden door op de rand van het object te klikken. Eén klik
selecteert het; een tweede Klik heft de selectie weer op. Om meerdere objecten te selecteren of de
selectie op te heffen, houd de Shift-toets ingedrukt tijdens het klikken.

Selectie door middel van frames

U kunt ook meerdere objecten tegelijk selecteren door er met de muis rondom te slepen. Dit tekent
een rechthoek rondom de objecten en alleen objecten, die volledig binnen deze rechthoek liggen,
worden geselecteerd.

Om meerdere objecten te selecteren door middel van frames, moet het pictogram Selecteren by
op de werkbalk Tekening geactiveerd zijn.

@ opmerking

Als met de muis wordt gesleept om meerdere objecten te selecteren, wordt de
selectierechthoek ook wel een selectiekader genoemd.

Verborgen objecten selecteren

Zelfs als objecten achter andere objecten verborgen zijn, kunnen ze nog steeds geselecteerd
worden. Houd de Alt-toets ingedrukt en klik op een object op de voorgrond, waarachter het
verborgen object ligt, klik dan opnieuw om het verborgen object te selecteren. Als er meerdere
objecten zijn, blijf dan de Alt-toets ingedrukt houden en klik net zo lang tot u het object bereikt dat u
wilt hebben. Om in omgekeerde volgorde door te objecten te bewegen, houd de toetscombinatie
Alt+Shift ingedrukt tijdens het klikken.

Als u op het geselecteerde object klikt, is de rand hiervan vaag door de objecten erboven
zichtbaar.

24 Kennismaken met Draw



@ opmerking

De methode met de Alt-toets werkt op computers met de besturingssystemen Windows
en Mac. Op een computer met een Linuxbesturingssysteem moet de methode met de
Tab-toets, zoals hieronder beschreven, worden gebruikt.

Om een object, dat onder andere objecten is verborgen, met het toetsenbord te selecteren, gebruik
de Tab-toets om door de objecten omlaag te bewegen en stop bij het object dat u wilt selecteren.
Om in omgekeerde volgorde door de objecten te bewegen, druk op Shift+Tab. Dit is een zeer
snelle manier om een object te bereiken, maar het zal niet erg praktisch zijn als de tekening een
groot aantal objecten bevat.

Objecten ordenen

In een complexe tekening kunnen verschillende objecten op elkaar gestapeld zijn. Selecteer het
object, kies Wijzigen > Schikken op de Menubalk en kies Naar voren of Naar achteren om de
stapelvolgorde opnieuw te schikken (een object van de voorzijde naar de achterzijde van de stapel
verplaatsen). Of klik met rechts op het object, kies Schikken uit het contextmenu en kies Naar
voren of Naar achteren.

De schikkingsopties zijn ook beschikbaar door op het kleine driehoekje rechts naast de knop

Schikking L7 - van de werkbalk Lijn en opvulstijl te klikken. Dit opent de werkbalk Positie en geeft
toegang tot de verschillende verplaatsingsopties (Afbeelding 28).

Positie v X
0@ QS

©0/00J00X0,

1|Vooraan 4| Achteraan 7 | Verwisselen
2| Naar voren 5|VO06r het object
3| Naar achteren 6 | Achter het object

Afbeelding 28: Werkbalk Positie

Verplaatsen en objectgrootte aanpassen

Wanneer u een object verplaatst of de grootte wijzigt, controleert u dan het linker gedeelte van de
statusbalk van Draw (Afbeelding 29). Het gebied links op de Statusbalk toont van links naar rechts:
soort object dat is geselecteerd, de positie van dit object in de tekening in X/Y-codrdinaten en de
afmetingen van het object. De maateenheden zijn degene die gekozen zijn in Extra > Opties >
LibreOffice Draw > Algemeen.

Voor meer informatie over verplaatsen van objecten en het aanpassen van de grootte, zie
Hoofdstuk 3, Werken met objecten en objectpunten, in de Handleiding van Draw

Verplaatsen en objectgrootte aanpassen 25



% - |=
= RS
o
, [
<
4 4 » ¥ | Lay-out [ Besturingselementen Maatlijnen |
Viorm geselecteerd | 0,50 / 23,90 #2430

Afbeelding 29: Linkerzijde van de Statusbalk bij het verplaatsen of het aanpassen van een
object

Objecten verplaatsen

Selecteer het object (of een groep objecten) door binnen de randen van het object te klikken en de
linker muisknop ingedrukt te houden terwijl u de muis versleept, om een object te verplaatsen.
Tijdens het verplaatsen verschijnt de vorm van het object als een vervaagde versie van de vorm
om te helpen bij de verplaatsing (Afbeelding 30). Laat de muisknop los om het object op zijn
nieuwe positie neer te zetten.

Afbeelding 30: Een object verplaatsen

De grootte van objecten aanpassen

Verplaats één van de handvatten rondom de selectie om de grootte van een object (of een groep
van geselecteerde objecten) met de muis te wijzigen. De muisaanwijzer verandert van vorm om de
richting aan te geven waarin het selectiehandvat zich beweegt. Als u de grootte van het object
wijzigt, verschijnt een vage rand om het object (Afbeelding 31). Laat de muisknop los als u de
gewenste afmeting hebt bereikt.

De resultaten zijn afhankelijk van welk handvat u gebruikt. Gebruik het handvat aan de zijkant om
de grootte van een object langs één as te wijzigen. Gebruik een handvat in de hoek om de grootte
langs beide assen te wijzigen.
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Afbeelding 31: Afmetingen
van een object aanpassen

@ opmerking

Als u op de Shift-toets drukt bij het aanpassen van de grootte van een object, zal de
verandering van de grootte symmetrisch worden uitgevoerd ten opzichte van de twee
assen; zodat de verhoudingen (hoogte/lengte) van het object hetzelfde blijven. Dit
gedrag van de Shift-toets werkt op alle handvatten.

Dit is het standaardgedrag van de Shift-toets. Als echter Tijdens aanmaken of
verplaatsen van objecten bij Extra > Opties > LibreOffice Draw > Raster is
geselecteerd, is de actie van de Shift-toets omgekeerd: dat wil zeggen, de verhouding
blijven intact tenzij de Shift-toets is ingedrukt.

Draaien en scheeftrekken van een object

Voor meer informatie over draaien en scheeftrekken van een object, zie Hoofdstuk 3, Werken met
objecten en objectpunten, in de Handleiding voor Draw.

Een object draaien

Om een object (of een groep objecten) te draaien, selecteer het object en gebruik één van de
volgende manieren om te draaien:

* Kiik op het pictogram Effecten & op de werkbalk Lijn en opvulstijl.
* Ga naar Beeld > Werkbalken > Modus en selecteer het picogram Draaien.

De selectiehandvatten veranderen van vorm en kleur (Afbeelding 32). Er verschijnt ook een
draaipunt in het midden van het object. Als u de muiswijzer over de handvatten beweegt verandert
de cursor van vorm. De handvatten in de hoekpunten zijn voor het draaien van een object en de
handvatten aan de bovenkant, onderkant en zijkanten zijn voor het scheeftrekken van het object.

Afbeelding 32: Een object draaien
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Plaats de muiswijzer boven één van de handvatten in de hoekpunten en het verandert normaal
gesproken in een boog met pijlpunten aan elk uiteinde. Klik en houd de muisknop ingedrukt en
begin dan de cursor te bewegen om het object te draaien. Een vervaagde versie van het object,
dat wordt gedraaid, verschijnt en de huidige hoek van draaiing wordt dynamisch weergegeven in
de statusbalk.

“ Opmerking

Het draaien werkt op een iets andere manier voor 3D-objecten, omdat de draaiing
plaatsvindt in een 3D-ruimte en niet in een viak. Zie hoofdstuk 7, Werken met 3D-
objecten, in de Handleiding voor Draw, betreffende draaiing wanneer de modus Punten
bewerken actief is.

Het draaipunt ligt normaal gesproken midden in het object. Om de plaats van het draaipunt te
wijzigen, klik met de muis op het object en sleep het object totdat het draaipunt op de gewenste
positie ten opzichte van het object ligt. U kunt ook het draaipunt zelf verslepen. Dit draaipunt kan
zelfs buiten het object liggen.

@ opmerking

Als u tijdens het draaien van het object de Shift-toets indrukt, zal de draaiing tot 15°
van de beweging beperkt zijn.

Dit is standaardgedrag van de Shift-toets. Als echter Tijdens aanmaken of
verplaatsen van objecten bij Extra > Opties > LibreOffice Draw > Raster is
geselecteerd, is de actie van de Shift-toets omgekeerd: dat wil zeggen, de draaiing is
beperkt tot 15° van de beweging tenzij de Shift-toets is ingedrukt.

Een object scheeftrekken

Gebruik de handvatten in het midden aan de bovenzijde, onderzijde of zijkanten van een
geselecteerd object om een object scheef te trekken. De muisaanwijzer verandert wanneer u deze
over één van deze handvatten in het midden beweegt. De as, die voor scheeftrekken van een
object wordt gebruikt, is de zijkant van het object direct tegenover het middelste handvat, dat om
het object scheef te trekken wordt gebruikt. Deze as blijft vast staan, terwijl de andere zijkanten
van het object daaraan gerelateerd bewegen, als u met de muiswijzer sleept.

Klik en houd de muisknop ingedrukt en beweeg dan de cursor om het object scheef te trekken.
Een vervaagde versie van het object, dat wordt scheef getrokken, verschijnt (Afbeelding 33) en de
huidige hoek van het scheeftrekken verschijnt in de Statusbalk.

@ Opmerking

Als u tijdens het scheeftrekken van een object de Shift-toets indrukt, zal het
scheeftrekken tot 15° van de beweging beperkt worden. Dit is standaardgedrag van de
Shift-toets. Als echter Tijdens aanmaken of verplaatsen van objecten bij Extra >
Opties > LibreOffice Draw > Raster is geselecteerd, is de actie van de Shift-toets
omgekeerd: dat wil zeggen, het scheeftrekken is beperkt tot 15° van de beweging tenzij
de Shift-toets is ingedrukt.
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Afbeelding 33: Een object
Scheeftrekken

Objecten bewerken

Om een object of de attributen van een object, zoals kleur en dikte van de rand te veranderen, kunt
u gebruik maken van de werkbalk Lijn en opvulstijl, de werkbalk Tekstopmaak, het paneel
Eigenschappen van de Zijbalk of het contextmenu. Meer informatie over het bewerken van
objecten en het veranderen van attributen kan worden gevonden in Hoofdstuk 4, Attributen van
een object wijzigen, in de Handleiding van Draw.

Werkbalk Lijn en opvulstijl

Standaard is de werkbalk Lijn en opvulstijl in Draw aan de bovenzijde van de werkruimte geplaatst.
Als de werkbalk Lijn en opvulstijl echter niet wordt getoond, ga naar Beeld > Werkbalken > Lijn
en opvulstijl op de Menubalk om de werkbalk te openen (Afbeelding 34). de meest gebruikte
attributen kunnen met gebruik van deze werkbalk worden bewerkt. U kunt ook het dialoogvenster

Lijn openen door op het pictogram Lijn & te klikken en het dialoogvenster Gebied door op het
pictogram Vlak A te klikken, om toegang tot meer opties te krijgen.

Lijn en opvulstijl v X

8 S~ |—v| A -[000cm i3 &‘Geen j J B e - Rd-a-
0]00), ®6 O ® OO BLEW® @

1 Stijlen en opmaak 7 Vlak 13 Spiegelen

2 Lijn 8 Opuvulstijl/Vullen 14 Positie en grootte
3 Pijlstijl 9 Opvulstijl/Vullen 15 Uitlijning

4 Lijnstijl 10 Schaduw 16 Schikken

5 Lijndikte 11 ImageMap

6 Lijnkleur 12 Effecten

Afbeelding 34: Werkbalk Lijn en opvulstijl
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Werkbalk Tekstopmaak

U kunt de werkbalk Tekstopmaak openen door deze te selecteren bij Beeld > Werkbalken op de
Menubalk. De gereedschappen op de werkbalken worden pas actief als er tekst geselecteerd is.

Tekstopmaak v X

Liberation Sans v vVRIE VCOMA-B-=s===s AW =-s==Eh A
© ® GO EEOHEE® @ @.@@@

1 Lettertype 10 Achtergrondkleur van tekst 19 Regelafstand: 1,5

2 Tekengrootte 11 Links uitlijnen 20 Regelafstand: 2

3 Lettertype vergroten 12 Horizontaal centreren 21 Tekstrichting van links naar rechts

4 Lettertype verkleinen 13 Rechts uitlijnen 22 Tekstrichting van boven naar beneden

5 Vet 14 Uitgevuld 23 Teken

6 Cursief 15 Van links naar rechts 24 Alinea

7 Onderstrepen 16 Van rechts naar links 25 Speciale tekens

8 Schaduw 17 Regelafstand

9 Tekstkleur 18 Regelafstand: 1

Afbeelding 35: Werkbalk Tekstopmaak

Eigenschappen van de Zijbalk

Als u een object in uw tekening selecteert, worden de gedeeltes in het paneel Eigenschappen van
de Zijbalk actief (Afbeelding 36). Hiermee kunt u de eigenschappen of opties van een object
aanpassen, zonder een dialoogvenster te hoeven openen of een gereedschap van de
verschillende werkbalken, die Draw levert, te gebruiken. Om een gedeelte uit te breiden, klik op het
plusteken (+) naast de titel van het gedeelte.

Eigenschappen X =
= Teken = @
Liberation Sans v 1118 | v :
}’r
V C O -we i KIX
- %&- 8- AR &
Alinea =
Gebied =
Lijn E1
Positie en grootte o=

Afbeelding 36: Gedeeltes van het Paneel Eigenschappen
van de Zijbalk
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Het contextmenu

Wanneer een object geselecteerd is, kunt u met de rechter muisknop op het object klikken om een
contextmenu, dat aan het object gerelateerd is te openen (Afbeelding 37). U kunt attributen van
een object wijzigen zonder een dialoogvenster te hoeven openen. Menu-items met een kleine pijl
aan de rechterkant bevatten een submenu.

# Knippen
55 Kopiéren
By Plakken
B Positie en grootte...
& Lijn..
Uitlijnen »
Schiken » LT Vooraan
Spiegelen » | L) Naar voren brengen
Converteren p | @ Naar achteren sturen
Opmaakprofiel bewerken... 87 Achteraan
@ Voor het object
[® Achter het object

Afbeelding 37: Voorbeeld van een contextmenu

Lijnen en randen opmaken

De term Lijn duidt in LibreOffice een vrijstaand segment aan (lijn), de buitenrand van een vorm
(rand) of een pijl. In de meeste gevallen zijn de eigenschappen die aangepast kunnen worden, de
stijl (doorlopend, gestippeld, onzichtbaar enzovoort), de dikte en de kleur.

Selecteer de lijn die u wilt opmaken en gebruik dan de gereedschappen op de werkbalk Lijn en

opvulistijl om de meest gebruikte opties te wijzigen (in Afbeelding 38 gemarkeerd).

Lijn en opvulstijl v X
B S|——v 4-020m{Z| A Kleur v - & H G- be - 22 -

Afbeelding 38: Veel gebruikte lijneigenschappen (lijnstijl,-dikte en -kleur)

Als u de weergave van de lijn verder wilt verfijnen, kies Opmaak > Lijn van de Menubalk, klik met

rechts op de lijn en kies Lijn in het contextmenu of selecteer het pictogram Lijn Eﬁ op de werkbalk
Lijn en opvulstijl. Al deze methodes openen het dialoogvenster Lijn (Afbeelding 14 op pagina 16),
waar u de lijneigenschappen kunt instellen. Dit dialoogvenster bestaat uit vier tabbladen: Lijn,
Schaduw, Lijnstijlen en Pijlstijlen. U kunt ook het gedeelte Lijn in het paneel Eigenschappen van de
Zijbalk gebruiken om de weergave van de lijn aan te passen.

Pijlen, pijlpunten en lijnuiteinden
Pijlen, pijlpunten en andere lijnuiteinden worden gewoonlijk aangeduid als pijlen en kunnen op
dezelfde manier behandeld worden als lijnen, wanneer de eigenschappen bewerkt en gewijzigd

worden. Selecteer een lijn en klik op het pictogram Pijlstijl g op de werkbalk Lijn en opvulstijl.
Dit opent het menu Pijlpunten (Afbeelding 39).
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Afbeelding 39: Menu Pijlpunten

Verschillende soorten pijlpunten zijn beschikbaar. Elk uiteinde van de lijn kan een andere pijlpunt
hebben (of geen pijlpunt). Pijlpunten kunt u alleen op lijnen toepassen. Ze hebben geen effect op
randen van een object.

De binnenkant (vulling) van een object opmaken

De term in LibreOffice voor de binnenzijde van een object is Vlakvulling. De vlakvulling van een
object kan een uniforme kleur, een kleurovergang, een arcering of een afbeelding zijn (Afbeelding
40). Een vulling van een gebied kan gedeeltelijk of geheel transparant worden gemaakt. In de
meeste gevallen zult u één van de standaard vullingsopties kiezen, welke op de werkbalk Lijn en
opvulistijl of in het gedeelte Gebied in het paneel Eigenschappen van de Zijbalk, beschikbaar zijn.
U kunt ook uw eigen vlakvulling maken. Voor meer informatie over het opmaken van een gebied,
zie Hoofdstuk 4, Objecteigenschappen wijzigen, in de Handleiding voor Draw.

Afbeelding 40: Verschillende vullingen van een
gebied

Opmaakprofielen gebruiken

Stel dat u dezelfde vlakvulling, lijndikte en randen op een verzameling objecten wilt toepassen. Dit
herhalend proces kan sterk worden vereenvoudigd door het gebruik van opmaakprofielen.
Opmaakprofielen maken het u mogelijk om een opmaaksjabloon (een groep opmaakprofielen) te
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definiéren en dat vervolgens toe te passen op meerdere objecten. Voor meer informatie over
opmaakprofielen, zie Hoofdstuk 3, Opmaakprofielen en sjablonen gebruiken, in dit boek, Hoofdstuk
6, Kennismaken met opmaakprofielen, in de Handleiding voor Writer en Hoofdstuk 4,
Objectattributen wijzigen van de Handleiding voor Draw.

Objecten plaatsen

Functie Vangen aan

In Draw kunnen objecten zeer precies en consistent geplaatst worden met de functie Vangen aan.
Rasterpunten, vangpunten en lijnen, objectframes, individuele punten op objecten of pagina-
uiteinden kunnen allemaal met de functie Vangen aan worden gebruikt.

De functie Vangen aan kan gemakkelijker gebruikt worden als u zo veel mogelijk inzoomt. Er
kunnen twee verschillende vangfuncties tegelijk worden gebruikt; bijvoorbeeld, Vangen aan een
hulplijn en Vangen aan een pagina-einde. Het is echter aan te bevelen om alleen de functies die u
echt nodig hebt te activeren.

Meer gedetailleerde informatie over de functie Vangen aan vindt u in Hoofdstuk 3, Werken met
objecten en objectpunten en Hoofdstuk 10, Gevorderde tekentechnieken, van de Handleiding voor
Draw.

Vangen aan raster

Met Vangen aan raster kunt u een object op een rasterpunt plaatsen (Afbeelding 41). Ga naar
Beeld > Raster > Vangen aan raster op de Menubalk of klik op het pictogram Vangen aan raster

e op de werkbalk Opties om de functie Vangen aan raster aan te zetten. Als de werkbalk Opties

niet zichtbaar is, ga naar Beeld > Werkbalken > Opties op de Menubalk.

Afbeelding 41: Plaatsing met Vangen aan raster

Het raster weergeven
Om het raster in Draw weer te geven of de weergave weer uit te zetten, ga naar Beeld > Raster >

Raster tonen op de Menubalk of klik op het pictogram Raster tonen i op de werkbalk Opties.
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Een raster configureren

De resolutie, vangen en vangpositie van de rasterpunten kunnen ingesteld worden. Ga naar Extra
> Opties > LibreOffice Draw > Raster op de Menubalk om het dialoogvenster voor het Raster te
openen (Afbeelding 42).

Raster
] Vangen aan raster
O Zichtbare raster

Resolutie Onderverdeling
Horizontaal: 1,00 cm = Horizontaal: |10 2 ruimte(s)
Verticaal: 1,00 cm 5 Verticaal: 10 = ruimte(s)

[1Synchroniseer assen

Vangen Vangpositie
[ Aan vanglijnen L Tijdens aanmaken of verplaatsen van objecten
[ Aan de paginamarges Randen uitbreiden
L1Aan objectframe OTijdens roteren: 15,00° =

[ Aan objectpunten Punten reduceren: |15,00°

Vangbereik: |5 beeldpur

Afbeelding 42: Het raster instellen

* Verticale en horizontale afstand van de punten in het raster. U kunt ook de maateenheid,
die in de algemene Draw-opties wordt gebruikt, aanpassen bij Extra > Opties >
LibreOffice Draw > Algemeen.

* De resolutie is de afmeting van de vierkantjes of rechthoekjes in het raster. Als de resolutie
horizontaal 1 cm en verticaal 2 cm is, dan bestaat het raster uit rechthoekjes van 2 cm
hoog en 1 cm breed.

* Onderverdeling zijn aanvullende punten die langs de zijden van elk rechthoekje of
vierkantje in het raster verschijnen. Objecten kunnen zowel Vangen aan onderverdelingen
als aan hoeken van het raster.

* De grootte van de pixels van het vangbereik bepalen hoe dicht u een object bij een
vangpunt of lijn moet brengen om het er aan te laten vangen.

* De standaardkleur van het raster is lichtgrijs. Om de kleur van de rasterpunten te wijzigen,
ga naar Extra > Opties > LibreOffice > Vormgeving op de Menubalk.

Hulplijnen

Draw heeft hulplijnen om de positie van een object gemakkelijk te kunnen bepalen, met gebruik
van de linialen aan de boven- en linkerzijde van de werkruimte. Om de hulplijnen aan of uit te
zetten, ga naar Extra > Opties > LibreOffice Draw > Weergave op de Menubalk en selecteer de
optie Vanglijnen bij het verplaatsen of ga naar de werkbalk Opties en klik op het pictogram
Helplijnen tijdens het verplaatsen i .

Speciale effecten toepassen

Met Draw kunt u veel speciale effecten op objecten en groepen van objecten toepassen. Dit
gedeelte is een introductie van een aantal van deze effecten. Meer informatie over speciale
effecten, is te vinden in hoofdstuk 4 Attributen van objecten wijzigen van de Handleiding voor
Draw.
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Om de gereedschappen voor speciale effecten te bereiken, ga naar Beeld > Werkbalken >

Modus (Afbeelding 43). Draaien en Spiegelen kan ook benaderd worden door naar Wijzigen op

de Menubalk te gaan of door met rechts op een object te klikken en het contextmenu te gebruiken.
Modus w XK

@ dvyd

60000000

1 Draaien 4 Op cirkel zetten (perspectivisch) 7 Transparantie
2 Spiegelen 5 Op cirkel zetten (schuintrekken) 8 Kleurovergang
3 In 3D-rotatieobject 6 Vervormen

Afbeelding 43: Werkbalk Modus

Een object spiegelen
De snelste en eenvoudigste manier om een object horizontaal of verticaal te spiegelen is als volgt:

1) KIlik op een grafisch object en de selectie-handvatten verschijnen.

2) KIlik met rechts en kies Spiegelen > Verticaal of Horizontaal of ga naar Wijzigen >
Spiegelen > Verticaal of Horizontaal op de Menubalk en het geselecteerde object zal
naar de tegenovergestelde richting gespiegeld worden.

Het gereedschap Spiegelen op de werkbalk Modus of de werkbalk Tekenen geeft echter een
grotere controle over het proces van spiegelen. Met het gereedschap Spiegelen kunt u de positie
en de hoek van het spiegelen van een object veranderen en dit wordt beschreven in Hoofdstuk 4,
Objectattributen wijzigen, in de Handleiding voor Draw.

Een spiegelbeeld maken

Op dit moment is er in Draw geen opdracht om een spiegelbeeld te maken. Het maken van een
spiegelbeeld van een object kan echter nagebootst worden door het gereedschap Spiegelen te
gebruiken, zoals wordt beschreven in Hoofdstuk 4, Objectattributen wijzigen, in de Handleiding
voor Draw.

Vervormen van een afbeelding

Er zijn drie gereedschappen in de werkbalk Modus, die het mogelijk maken de hoeken en randen
van een object te verslepen om het beeld te vervormen.

7 Vervormen vervormt een object in perspectief.
&7 Op cirkel zetten (schuintrekken) creéert een pseudo driedimensionaal effect.
@’  Op cirkel zetten (perspectivisch) creéert een pseudo driedimensionaal effect.

In alle drie gevallen wordt u in eerste instantie gevraagd of u het object in een boog wilt
converteren. Dit is een noodzakelijke eerste stap, klik dus op Ja. Daarna kunt u de handvatten van
het object verplaatsen om het gewenste effect te bereiken. Zie Hoofdstuk 4, Objectattributen
wijzigen, in de Handleiding voor Draw, voor meer informatie over het vervormen van een object.
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Dynamische kleurovergangen

U kunt de transparantie van kleurovergangen en kleurovergangen op dezelfde wijze beheren.
Beide soorten kleurovergangen kunnen samen worden gebruikt. Met een transparante
kleurovergang verandert de richting en de mate van opvullen van een object van ondoorzichtig
naar transparant. In een normale kleurovergang verandert de ene kleur naar de andere, maar de
mate van transparantie blijft hetzelfde.

De gereedschappen voor Transparantie en Kleurovergang op de werkbalk Modus geven een
dynamische controle over de transparantie en kleurovergangen. Zie Hoofdstuk 4, Objectattributen
wijzigen, in de Handleiding voor Draw, voor meer informatie over hoe hoe transparantie en
kleurovergangen in een object te creéren.

Dupliceren

Dupliceren maakt kopieén van een object en past een aantal wijzigingen, zoals kleur of draaiing,
toe op de duplicaten.

1) Kilik op een object (of op een groep geselecteerde objecten) en kies dan Bewerken >
Dupliceren of de toetscombinatie Shift+F3, om met dupliceren te beginnen en het
dialoogvenster Dupliceren te openen (Afbeelding 44).

Dupliceren X
Aantal kopiegn: |1 o | &£
Verplaatsing
= Annuleren
X-as: 0,50 cm =
Y-as: 0,50 cm - Standaard
Draaihoek: 0° =
Uitbreiding
Breedte: 0,00 ecm =
Hoogte: 0,00 cm =
Kleuren
Starten: ‘- LibreOfficeGreen1 V‘
Einde: ‘- LibreOfficeGreen V‘ —=l:

Afbeelding 44: Dialoogvenster Dupliceren

2) Kies de gewenste opties uit de beschikbare. Bijvoorbeeld, als de opties in het
dialoogvenster op een rechthoek worden toegepast, wordt het resultaat als in Afbeelding
45.
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Afbeelding 45: Resultaat van
dupliceren

Vormovergang

Vormovergang transformeert een vorm van een object naar een ander en werkt alleen als er twee
objecten zijn geselecteerd.
1) Selecteer twee objecten met een verschillende vorm.
2) Ga naar Bewerken > Vormovergang op de Menubalk om het dialoogvenster
Vormovergang te openen (Afbeelding 46).
3) Kies de stapgrootte om het aantal vormen tussen de twee objecten te bepalen.
4) Selecteer Vormgevingsattributen om een geleidelijke aanpassing van de lijn- en
vullingseigenschappen tussen de twee objecten toe te passen.
5) Selecteer Zelfde oriéntatie om een vioeiende overgang tussen de twee objecten te krijgen.
6) Klik op OK en het resultaat is een nieuwe groep objecten met het eerste geselecteerde
object als beginobject en het tweede geselecteerde object als eindobject. Bijvoorbeeld, als
de twee opties in het dialoogvenster op een vierkant en een driehoek worden toegepast,
geeft de Vormovergang het resultaat als in Afbeelding 47.

Vormovergang... X

Instellingen

Y

Stappen: 16 -

Vormovergangsattributen
Zelfde oriéntatie

Help oK Annuleren

Afbeelding 46: Dialoogvenster VVormovergang
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Afbeelding 47: Resultaat van VVormovergang

Het combineren van meerdere objecten

Met behulp van Draw kunt u tekenobjecten met elkaar groeperen of samenvoegen en
meervoudige objecten als één geheel behandelen of objecten in één nieuwe vorm samenvoegen.
Meer informatie vindt u in Hoofdstuk 5, Meerdere objecten samenvoegen, van de Handleiding voor
Draw.

Groeperen is zoals het samenbrengen van objecten in een container. U kunt ze als een groep
verplaatsen en algemene wijzigingen op de objecten in de groep aanbrengen. Een groepering kan
altijd ongedaan worden gemaakt en de objecten, die de groep vormen, kunnen altijd afzonderlijk
worden gemanipuleerd. De objecten in de groep behouden ook hun eigen individuele
eigenschappen.

Een Samenvoeging is een permanente fusie van objecten die leidt tot een nieuw object. De
oorspronkelijke objecten zijn niet meer als individuele entiteiten beschikbaar en kunnen niet meer
als individuele objecten worden bewerkt. Elke aanpassing van een samengevoegd object heeft
invloed op alle objecten die voor de samenvoeging werden gebruikt.

Groeperen

Tijdelijk groeperen

Tijdelijk groeperen is wanneer verschillende objecten geselecteerd werden middels het pictogram
Selecteren op de werkbalk Tekening of door met de muis een rechthoek rond de objecten te
trekken (ook wel selectiekader genoemd). Elke wijzing aan objectparameters worden op alle
objecten in de tijdelijke groep toepast. Bijvoorbeeld, u kunt een tijdelijke groep objecten in zijn
geheel draaien.

Om een tijdelijk groep op te heffen, klikt u simpelweg buiten de selectie-handvatten, die rondom de
objecten staan.

Permanent groeperen

Een permanente groep objecten wordt gemaakt, nadat u de objecten geselecteerd hebt en dan
naar Wijzigen > Groeperen op de Menubalk gaat, in de selectie met rechts klikt en Groeperen in
het contextmenu selecteert of de toetscombinatie Ctrl+Shift+G gebruikt. Als u uw selectie
ongedaan maakt blijven de objecten gegroepeerd.

Als objecten permanent gegroepeerd zijn, wordt elke bewerking op alle leden van de groep
toegepast. Als u op een lid van de groep klikt, wordt de hele groep geselecteerd.

U kunt een lid van een groepering afzonderlijk bewerken zonder de groep te verbreken. Selecteer
de groep en ga naar Wijzigen > Groepering betreden, klik met rechts en kies Groepering
betreden in het contextmenu, gebruik de toets F3 of dubbelklik op de groep.
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Als u klaar bent met het bewerken van een afzonderlijk lid van de groepering, ga dan naar
Wijzigen > Groepering verlaten, klik met rechts en kies Groepering verlaten in het contextmenu
of gebruik de toetscombinatie Shift+F3.

Groepering opheffen

Om een groepering op te heffen of een groep van objecten van elkaar los te maken, selecteer de
groepering en ga naar Wijzigen > Groepering opheffen op de Menubalk, klik met rechts en kies
Groepering opheffen in het contextmenu of gebruik de toetscombinatie Ctrl+Alt+Shift+G.

Objecten samenvoegen

Objecten samenvoegen is een permanente samenvoeging van objecten die een nieuw project
maken. De oorspronkelijke objecten zijn niet meer als individuele entiteiten beschikbaar en kunnen
niet meer als individuele objecten bewerkt worden. Elke bewerking van een samengevoegd object
heeft invioed op alle objecten die voor de samenvoeging werden gebruikt.

Selecteer een verzameling objecten, en ga naar Wijziging > Samenvoegen op de Menubalk, klik
met de rechtermuisknop op de objecten en kies Samenvoegen in het contextmenu of gebruik de
toetscombinatie Ctrl+Shift+K.

Nadat u uw objecten heeft geselecteerd, komen de functies Samenvoegen, Aftrekken en
Doorsnijden beschikbaar, zodat u nieuwe objecten van uw selectie kunt maken. Zie Hoofdstuk 5,
Het samenvoegen van meerdere objecten, van de Handleiding voor Draw, voor meer informatie
over deze functies.

Schikken, uitlijnen en verdelen van objecten

In Draw kunt u objecten ten opzichte van elkaar schikken, uitlijnen en verdelen:
* De positie van een object wijzigingen door het voorwaarts of achterwaarts te verplaatsen in
de volgorde van de objecten.

* Objecten ten opzichte van elkaar uitlijnen, met behulp van Links, Gecentreerd of Rechts,
voor horizontale uitlijning, en Boven, Midden of Beneden voor verticale uitlijning.

* De objecten zodanig verdelen, dat de ruimte tussen ieder object gelijk is.

Zie hoofdstuk 5, Het samenvoegen van meerdere objecten, in de Handleiding voor Draw voor
meer informatie over het ten opzichte van elkaar schikken en uitlijnen van objecten.

Invoegen en bewerken van foto's

Draw bevat een aantal functies voor het bewerken van rasterafbeeldingen (bitmaps) — bijvoorbeeld
foto's en gescande afbeeldingen. Dit omvat ook het importeren en exporteren van afbeeldingen
alsmede omzetting van het ene formaat naar het andere.

Draw biedt een groot aantal grafische filters, zodat het verschillende grafische bestandsformaten
kan lezen en weergeven. Het bevat ook verschillende gereedschappen voor het werken met
rasterafbeeldingen, maar het heeft niet dezelfde functionaliteiten als gespecialiseerde grafische
programma'’s, zoals Gimp of Adobe Photoshop. Zie Hoofdstuk 6, Afbeeldingen bewerken, van de
Handleiding voor Draw, voor meer informatie.

U kunt foto's uit verschillende bronnen invoegen:

* Rechtstreeks vanaf een scanner (Invoegen > Afbeelding > Scannen).

* Foto's gemaakt door een ander programma, inclusief foto's van een digitale camera
(Invoegen > Afbeelding > Uit bestand).
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* De Galerij van Draw - zie hoofdstuk 11, Afbeeldingen, de Galerij en Fontwork, in dit boek
voor meer informatie.

Werken met 3D-objecten

Hoewel Draw niet dezelfde functionaliteiten heeft als de toonaangevende teken- of
fotobewerkingsprogramma's, is het in staat om zeer goede 3D-tekeningen te produceren en te
bewerken.

Draw biedt twee soorten 3D-objecten aan: 3D-lichamen, en 3D-vormen. Afthankelijk van welk type
u kiest, zijn er verschillende mogelijkheden voor verdere bewerking van het object (rotatie,
belichting, perspectief enzovoort). 3D-vormen zijn eenvoudiger in te stellen en te bewerken, maar
3D-lichamen kunnen meer aangepast worden.

Zie hoofdstuk 7, Werken met 3D-objecten, in de Handleiding voor Draw, voor details.

Afbeeldingen exporteren

Draw slaat afbeeldingen en tekeningen op in het open source formaat *.odg. Gebruik Bestand >
Exporteren en kies een formaat uit de keuzelijst om een afbeelding of het gehele bestand in een
andere indeling op te slaan. Draw kan bestanden in veel verschillende grafische bestandsformaten
opslaan, zoals vermeld in Appendix B, Open source, Open standaarden, Open document, van dit
boek.

U kunt Draw-bestanden ook exporteren naar HTML, XHTML, PDF of Flash. PDF-export is
hetzelfde als voor andere delen in LibreOffice, zoals beschreven in Hoofdstuk 10 Afdrukken, e-
mailen en exporteren van dit boek.

HTML-export maakt gebruik van een conversie assistent die evenveel webpagina's maakt als er
pagina's in uw Draw document zijn. U kunt er desgewenst voor kiezen om de pagina's in frames
met een navigator weer te geven en een index pagina aan te maken. Voor meer informatie, zie
hoofdstuk 12, Webpagina's maken, van dit boek.

Notities aan een tekening toevoegen

U kunt notities in uw tekening toevoegen en dit werkt hetzelfde als in Writer en Calc.

1) Kies Invoegen > Notitie op de Menubalk. Een klein vakje, met daarin uw initialen,
verschijnt in de linker bovenhoek van uw tekening, met een groter tekstvak ernaast
(Afbeelding 48). Draw heeft automatisch uw naam en de datum aan de onderzijde van dit
tekstvak toegevoegd.

2) Typ of plak uw notitie in het tekstvak. Optioneel kunt u enige basale opmaak toepassen op
de delen van de tekst door deze te selecteren, met rechts te klikken en te kiezen uit het
contextmenu. Vanuit dit menu kunt u de huidige notitie, alle notities van dezelfde auteur of
alle notities in het document verwijderen.

3) U kunt de kleine markeringen van de notitie op de tekening verplaatsen waarheen u wilt.
Gewoonlijk zult u het op of nabij een object plaatsen waarnaar u verwijst in de notitie.

4) Kies Beeld > Notities op de Menubalk om de markeringen van de notities weer te geven of
te verbergen.
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Afbeelding 48: Een notitie invoegen

U kunt naar Extra > Opties > Gebruikersgegevens gaan, om de naam in te voeren die u in het
veld Auteur van de notitie wilt laten verschijnen.

Als meer dan één persoon het document bewerkt, krijgt elke auteur automatisch een andere
achtergrondkleur toegewezen.

Notities aan een tekening toevoegen
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